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Introduction

Welcome to Autodesk® Apprentice Remote, a software program designed to improve the CAD plotting process.

Apprentice allows you to preview and prepare a set of CAD files, predetermine output options, and print

or submit the job electronically.

Minimum System Requirements

* 64 MB RAM

+ 60 MB free hard drive space

* Windows NT with Service Pack 5 or Windows 95 or 98
* Windows 2000 with Service Pack 2

Supported File Formats

Vector Raster
* AutoCAD® DWG (R2.5-R2002)* + CALS Group IV
*« HPGL * NIFF Group IV
* HPGL/2 * TIFF Group IV
* HP-RTL (color and monochrome) « TIFF Group III
+ CalComp 906/907/PCI * TIFF packbits
« TTIFF Uncompressed

* PostScript (with 3rd-party interpreter)
* PDF (with 3rd-party interpreter)

Overview of Apprentice Remote

Using Apprentice involves four basic steps:

1. Add drawing files to a job.

2. Set print properties such as paper size, scale, etc.

3. Process drawings for viewing or to print to a small-format printer.
4. Send the job to a Windows printer, publish to the Internet, submit

to an Apprentice server queue, or archive.

* Apprentice DWG update required.
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Setting AutoCAD Properties

To control AutoCAD® print properties, click a DWG file in the job window to select it, then click the
Properties button.

For AutoCAD files, you must select your plotting method:
* Extents will plot the current viewport if you have selected Zoom Extents in AutoCAD.
* Limits will plot the limits of the drawings as set by the AutoCAD limit command in the drawing file.
* Display will plot what is currently displayed in the current AutoCAD viewport.

* View will plot a view saved in AutoCAD. Selecting this option will prompt you to select one of
the saved views.

* Layout will plot based on layouts predetermined in AutoCAD 2000.
After you set your plotting method, select an AutoCAD scale (Full,1/4, etc.)

Use the scrollbar at the right of the AutoCAD Properties page to change properties for each file or click
Copy All to use the same settings for all DWG files.

Please see Plotting With AutoCAD 2000 Tips for Apprentice Users in the Apprentice Training & Support
section of the Buzzsaw website.

The Apprentice DWG update is required to process AutoCAD DWG files.
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Step 3: To process drawings

Vector file formats are processed into a compressed format (.VIC) that is optimized for
digital printing. Follow the instructions below to process all drawings in a job. Raster files

such as TIFF and CALS do not require processing.

)
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Froceszz

Click the Process button. All vector files are processed. Processed files are indicated with a check
mark next to the file name.

<< | File = Co... |Drawing Size = Soom = |Paper Size = i
1 282x180In 1000%  AchD: 3602401 B
1 420x3000R 90xE.0in F
1 33Ex24.0in 1000%  ArchD: 36.0x24.0ir B
1 420x3000n 1000%  AchC: 24.0x18.0In%

Check marks in the File column indicate the drawing has been processed.

If Apprentice detects errors during processing, warning messages will offer advice on how to resolve them.

View Drawings in a Job

1. In the job window, click a drawing
to be viewed to select it, then click
the View button. The drawing

appears in the viewer.

2. Use the toolbar on the right side of
the screen to check and fine-tune
the appearance of the drawings.

3. Modifications in the View window
will also modify the way the files are

printed.

Fit Page: Displays entire
image in viewer.

Move Drawing: Manually
adjusts position of a drawing.

—>

Zoom Select: Moves view of
drawing closer or further away by

Border Removal: Removes
border/trim marks from
edges of a drawing.

using the left and right mouse
buttons.

Edit Pen: Change properties
of a selected pen, such as
thickness or pattern.

Pan View: Moves view across
paper but does not move drawing.

Clip Drawing Outside: Areas out-
side of a selected drawing.

Center Drawing: Centers
drawing on paper.

v

A

Enlarge Detail: Increases size of a
selected area of drawing to cur-
rent paper size.

Tile Block Align: Aligns
according to top, bottom,
and right edges of paper.

A

Mirror: Reverses drawing informa-

A=EINNE

Rotate Drawing Left:
Rotates a drawing 90°
counterclockwise.

b3
=

tion for mirror image.

Rotate Drawing Right: Rotates a
drawing 90° dockwise.

[
Fz

Toggle Rasterization:
Rasterizes image in viewer so
that pen thicknesses, patterns
are displayed.

Outline Polygon: Removes
fills from solid polygons in
viewer.

{ Flip Drawing: Rotates drawing 180°

Negative Paper: Reverses back-

e [

ground color of viewer from white
to black.

Lo

A

Toggle Color Patterns: Applies
color patterns to lines in viewer.
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Step 3, continued

Print Check Plots

Apprentice Remote can print any supported image up to 9 x 12 inches directly to a Windows printer.

. . . Print
To print to a Windows printer: :
— Pririter
. . Narmne: PBroperties |
1. Click the Print button.

Status: Ready
Type: HF C Lazerlet 4500-F5

2. Select Windows printing ‘where:  Print Room 2
parameter, and click OK. Comment: Colar Laser)st ™ Frint ta file
— Prinit range Copies
The paper size of a Windows printer is & Al Mumberof gopies. |1 =
controlled by the current printer set- € Pagee. pome | il I 'E 'H
tings in Windows, not the paper size in £ Selection
Apprentice Remote.

ak I Cahicel

If you wish to print in color in
Apprentice, open the Options menu and select Windows Printer Uses Color.

Step 4: To send the job

Apprentice jobs can be sent by modem, FTP, or LAN. Jobs can also be posted to a g

ProjectPoint™ collaboration site, or published to a Plans & Specs™ digital plan room. Pibish

To publish an Apprentice job to a Plans & Specs digital plan room:
1. Open the job containing the files you wish to send.

2. In the toolbar, click Publish. The conversion progress bar shows the conversion progress, then the
Plans&Specs Logon message appears.

3. Click Log On. The Login dialog box appears.
4. Enter your www.buzzsaw.com user name and password and the containerlocation for your reprographer.
5. Click OK. The Plans & Specs Navigation dialog box appears.

(continued)
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Step 4, continued

6. Click Take you to the last issue used or Let you navigate on your own,then click OK. The Plans & Specs
system publishing wizard appears:

Plans & Spexs Publsbung Slep 1 ol 2 - DAWINHT VempiBILZS S

¥ Show Thtbos iz e | || REsEsR | camsd | e |

7. In the tree view, click the plus sign for each container level to showsubcontainers OR
In the browser window, double-click each container icon to showsubcontainers. Navigate to the issue in
which you wish to publish the documents.

8. Open the issue.

9. If the issue is empty, the Add File button becomes available. Click Add File. OR

If the issue contains documents, several buttons become available. Click a document to select it, then click:
> New File After to publish your Apprentice documents behind the selected file.
> New File Before to publish your Apprentice documents in front of the selected file.
> Republish to publish your Apprentice documents over the existing file.

The Publish LDF file dialog box appears:

10. Double-click any field for any document to enter new information. Press Enter on the keyboard to save
the new information:
o -1

Fie | SheetMame | Descripion | Dinciplne | Pl 1
o Melyal (20013144811 45]L0OF  Nedr-al Elecirical “Newo

Vi Arcount Cheni Paoject )

[ Decsbe [Tiamwgiccont [Tt [FearmgFiomet Temrwgvm
B.mlml Cancel

11. Click Publish. A confirmation message appears. The documents are published to Plans & Specs.

=t Mame ‘ Crescrphion ‘ DisciEIine
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Step 4, continued

To send to ProjectPoint, a network queue, a modem, or disk:

1. With the Job window open, click the
Send Job button.

2. The Send Job To dialog box
appears. Select ProjectPoint,
Modem, Queue or Drive and any

required location, then click OK.

3. The Work Order appears. Complete
the appropriate information and
click Submit. The job is sent and

the order receipt appears.

Send Job To._.

% ProjectPaoint
ProjectPoint Folders and Projects

j Select... |

1 Queue
Bath Ta Eueue
I j Browss... |
" Modem

EommmumEators Method

@ I j e |
~ Diive
H [riwe Letter
B
ok |
| imbinformation |

Send Job to €2\,

[Busesaweom

Comaet [ogsom

E-Mall Address. W
[eaz 5550212

[A56998-001

1850 North Cantral Avenue
Fhoeno
ES004

[#94S0uth Canral Averae
[Buterson
% [Fhosex
s [z
mmlwi

Propect  [How Stadium
PO Wb [Soap500
DalvaryMethod  [Cocai Colrery =]

I Reimbursable:

Kb DR [Januar,  =||1 =] 2000 =]
Job Dwe Tene 200 =] [abt =]

SefCound = jse Belkdo © Use Coples Field
FistSetMedia [Gona =]

Firsd SetEQQING [ Stngle Cnly ~]
additional Sei Couk [T
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Appendix
About Pen Sets
Pen = |Width — Pattern — Mumber ~ |Shape — Effect — Colar ~— =
@ 0] 0.25mm [SclidBlack 0 Fiound Transparent [l rob(0.0.0)
: @ 1] 013mm [lSolidBlack 0 Sruare Transparent [l rgb(255.0.0)
Pen Sets. COl‘ltI‘Ol the appe.arance Of .11nes. @ 2| 019mm ﬁ 75% Black q Found Cpague rgb(255.255,0)
Properties such as line width, shadmg and color @ 3| 0.25mm lSolidBlack 0 ButEnded  Transparent [ rgh(0.255,0)
. . . @ 4] 025mm - Ziggurat 115 Found Transparent rghi0.255,255)
can all be set within Apprentlce. Pen sets use @ & 075mm [ SolidBlack 0 Found Transparent [l rab(.0.255)
: @ 6| 025mm SoidBlack 0 Raund EE N O i1 (255.0,255)
standard AutoCAD® colors by default (pen 1 is @ 7| 025mm [SolidBlack 0 Found Transparem  rgb(255.255.28
3 @ 8 025 SolidBlack 0 Found T t bi126128 157
red, pen 2 is yellow, etc.). - o M Solid Blad oun ransoorent M roo(126.12 _>|7|

If you are using plot files with embedded pen widths, colors, patterns, etc., you can use embedded pen
information or override the embedded pens and use an Apprentice pen set. Press <Ctrl> + H on your
keyboard to access these pen controls. For more information, see the online help topic "HP-GL/2 pen
control tab."

After installing Apprentice, you should configure your default pen set. Every time Apprentice
starts, it uses a default pen set called standard.pen. Apprentice supports an unlimited number
of reusable pen sets.

Configure a pen set g

1. Select a drawing and click the Pen Set button. Pen Set
The current pen set appears:

< Pont _[O] x|
Pen = |Width = Pattern = MHumber = |Shape = Effect = Color = -
® 0| 025mm [ SolidBlack 0 Round Transparent [ rab(0.0.0)

@ 1| 013mm [JSclidBlack 0 Square Transparent [ rab(255.0,0)

® 2| 019%mm 5 75% Black q Faound Opague rgh(255.255.0)

@ 3| 025mm [JSclidBlack 0 ButtEnded  Transparent [ rgh(0,255.0)

@® 4| 0.25mm -5 Ziggurat 115 Fiound Transparent rgh(0, 255, 255)

w 5| 025mm [JJSolidBlack 0 Found Transparent [ robi0.0.255)

@ 6| 025mm [SclidBlack 0 Round “rgb(EEEﬂ,EEE)
w 7| 025mm [JJSolidBlack 0 Found Transparent rgh(2h6 265, 2F
t'ii 8| 0.25mm [l SclidBlack 0 Found Transparent .rqbﬂEEJ?Eii;l
. v

2. See the next page in this guide to edit individual pens.

3. After you edit the pen set, save it for future use by opening the File menu and selecting Save.
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Pen properties

Right-click on a selected pen Apprentice Remote has 127 built-in pen patterns. Right-click a
width to see a menu of selected pen pattern to see a list of common settings or click the
common settings, or click Properties button to choose from all patterns. Each pattern has a
Properties in the toolbar to corresponding number.

choose from all widths.

Pen = |“Widh = Pattern = Mumber = | Shape = Effect = Color = -

@ 0 0¥smm PSclidBlack 0 Fiound Transparent [frab(0.0.0)

@ 1/ 013mm [JSclidBlack 0 Sguare Transparent [ robi255.0.0)

@ 2| 019mm {8 75% Black 4 Fiound Opague roh(256,256,0)

@ 3| 025mm [SclidBlack 0 ButtEnded  Transparent [ rgh{0.255.0)

@ 4| 0.25mm . Ziggurat 115 Found Transparent rgh(0.255,255)

@ & 0265mm [JSclidBlack 0 Fiound Transparent [ rab(0.0,255)

® G| 025mm [JSolidBlack 0 Found Wrgb(ZEE,DEEE]

@ 7| 026mm [JSclidBlack 0 Found Trans%rent rgh(266,256,2F

@ 8| 025mm W SolidBlack 0 Ficfnd Transpferent [ rgb(128.1 EBiill

4] | | | Bl

| |

Click this column to Pen shape refers to the Pen effect refers to the

change the unit of meas- appearance of the tip of a appearance of a line when it

urement for all pens (mm, pen. Round pens have a intersects with another. A

inches, cm, pixels) rounded tip; square have a line can be transparent,
pointed tip, and butt-ended opaque, or reverse (Xor).
pens have no tip.

Get Help

Online help is available by opening the Help menu and clicking Index.

Additional documentation is contained in the Apprentice User Manual on the installation CD, or on the
Buzzsaw web site at www.buzzsaw.com. Both the online help and the manual contain full-text search capability.

Upgrades

Apprentice Remote can only print 8.5x11” locally. However, you can purchase an output “
driver that will allow Apprentice to print full-size to your local wide-format printer. Please _
call (800) 782-0753 for more information. Frint
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